
  



Building Your Book for Kindle Using Microsoft Word 2011 (Mac version) 

 

We are excited you’ve decided to design, format, and prepare your book for Kindle! We’ll walk you 

through the necessary steps in creating a professional digital file of your book for quick upload to Kindle 

Direct Publishing. These are the topics we’ll discuss:  

 

 Before You Write 

 Building the Front Matter of Your Book 

 Building Your Table of Contents 

 Preparing a Cover 

 Finishing Your Book 

 Uploading and Checking the Quality of Your Book 

 Just Before Publishing Your Book 

 Making Changes After Publishing Your Book 

 

We’ve written this guide with you in mind. We’ll walk you through the key steps for every part of the 

process, and while it may seem repetitive at times, we want to make sure you have exactly the 

information you need, when you need it.  

And don’t forget - this is a process!  Publishing on Kindle is easy and takes only 5 minutes of your time—

but correctly preparing your book for success on Kindle takes time and effort. Don’t worry; if you follow 

the steps we outline here, you should feel confident you’ll end up with a successfully designed and 

formatted book and one you will be proud to see for sale on Amazon. You will even be able to verify this 

with our Previewer! 

Let’s get started! 

  



Before You Write 

 

If you have already written your book, you can skip ahead to the next section for help preparing your 

book for Kindle. If you haven’t written it yet (or think you might write another book later), this section 

offers tips for consideration during the writing process to ease the conversion process later.   

To publish on Kindle, authors generally write in Microsoft Word processing software and  convert the 

file to Kindle’s format after completion.  Suggestions here are specific to Microsoft Word 2011 for Mac, 

though the steps are the same in nearly all versions of Word. If the content you would like to edit is not 

in Word format, we suggest seeking professional formatting help. 

If you're unable to use Microsoft Word, you can also try OpenOffice or LibreOffice.  You can read more 

about OpenOffice and download it here: http://www.openoffice.org/download/index.html and see 

more about LibreOffice and download it here: http://www.libreoffice.org/download/.  Be sure to check 

the Help or Support sections of each website if you have further questions about using these products. 

Also, if your book is more elaborate than this, for example with many graphics, tables or images, or is 

larger than 50 megabytes, we suggest referring instead to Amazon’s Kindle Publishing Guidelines. 

 

Tips for Formatting 

The most common mistake new digital publishers make is assuming formatted material will translate to 

Kindle as “what you see is what you get.” These tips will help avoid common mistakes in the conversion 

process. 

 Insert indents at the beginning of paragraphs:  Avoid using tabs and spaces to indent 

paragraphs and icons. To set “first line” indents (for paragraphs) in Word: 

o Click on the “Format” dropdown menu at the top of the screen in Word and select 

“Paragraph” 

o In the dialogue screen, locate the “Indentation” section, and set “Special” to “First line” 

and “By” to your preferred indent (in the example below 0.5”, which is the setting we 

recommend, if you want your first line to be indented).  

 

http://www.openoffice.org/download/index.html
http://www.libreoffice.org/download/
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf


 Insert empty space between paragraphs:  If you insert a “return” (or carriage return) between 
two paragraphs you cannot be ensured that the space between paragraphs will appear correctly 
on all Kindle platforms.  Instead, set your paragraph spacing in Word as follows:  

o Click on the Format drop down menu at the top of the screen and select “Paragraph” 

o In the “Paragraph” section of this tab, locate the section entitled “Indent” 
o Next to the word “After”, you can enter a value for your preferred space after a 

paragraph (in the example below, Word will allow a 10 point space after a paragraph, 
before the next paragraph). 

 

 Insert page breaks between chapters: Enter a page break at the end of every chapter to prevent 

the text from running together on Kindle. To insert a page break in Word: 

o In your document, position your cursor where you would like the page break 

o Click on the “Insert” dropdown menu at the top of the screen in Word 

o In the dropdown menu, hover your mouse pointer over the word “Break” 

o From the flyout that appears to the right of the word “Break” click on “Page Break” 

 

 Show/Hide: Clicking the Show/Hide [¶] button in Word will toggle on and off a Word feature 

that shows you paragraph marks and other formatting symbols. These symbols will not be 

visible on the Kindle, but you can use them to see where you have inserted page breaks, 

paragraph breaks, etc., all of which will help you understand how your book will look on kindle. 

For example, if you set empty spaces between paragraphs as described above, those spaces will 

appear after each of the ¶ marks in your document. To toggle “Show/Hide”in Word: 

o The Show/Hide [¶] button in Word on a Mac is on the Standard toolbar.   

o If you do not see the Show/Hide [¶] button at the top of the screen in Word, you may 

have to turn on the Standard toolbar. 

o To turn on the Standard toolbar, click on the “View” dropdown menu at the top of the 

screen in Word 

o Click on the word “Toolbars” in the dropdown 

o In the flyout that appears next to the word “Toolbars”, if the word “Standard” does not 

have a check next to it, click on the word “Standard” so that it is now checked.  This will 

display the Standard toolbar at the top of the screen in Word, and you should now be 

able to locate and click the ¶ button, revealing paragraph marks and other formatting 

symbols.   

 



 Avoid pasting in images: Images should be inserted in JPEG (or .jpg) format with center 

alignment (don't copy and paste from another source).   

o Click on the “Insert” dropdown menu at the top of the screen in Word 

o In the dropdown menu, hover your mouse pointer over the word “Photograph” 

o In the flyout that appears next to the word “Photograph”, click “Picture from File” 

o In the dialogue screen, locate and select the file 

If your book has a lot of images, it can be viewed in color by readers using Kindle Fire or our free 

Kindle apps for PC, Mac, iPad, iPhone, and Android. Otherwise, remember that images on Kindle 

e-ink devices are displayed in 16 shades of gray for great contrast and clarity. 

 Do not use headers and footers: Headers, such as title and chapter, and footers, such as page 

number, will not display on Kindle as intended; avoid using them. 

 

 Use Word’s “Heading1-6” formatting styles for chapter titles and other emphasized text: 

Kindle will support easy navigation within your book for the reader if you highlight chapter titles 

(e.g., “Chapter 1”) and set them to a “Heading” value as shown below.   

o In your manuscript, highlight the chapter title with your mouse 

o Click on the “Home” tab 

o Click on the “Heading 1” button as shown below 

o Your text will be formatted differently.  You can change the formatting values for 

“Heading 1” to anything you wish by right-clicking on the same button and selecting 

“Modify” 

o If you have already formatted your chapter headings the way you would like, you can 

highlight the heading, right-click on “Heading 1” and select “Update Heading 1 to Match 

Selection.” After this, anything you set to Heading 1 will match the settings you selected. 

 



 

 Font size: Kindle readers can reconfigure the text size (i.e., font size) and margins while reading 

on Kindle.  Because of this, you may wish to avoid utilizing font size to add emphasis. 

  



Building the Front Matter of Your Book 

 
The front matter is everything between your book’s cover and first chapter. Front matter may include a 

title page, copyright page, dedication, preface or prologue. At minimum, your front matter should 

include a title page.  Below are some tips to help make your front matter look stylish and professional. 

 Title page: The first page in your manuscript document should be your title page (you will 

upload your cover page, an image, separately when you publish your book).  Your title page 

should be centered with the book title on top and the author name underneath. 

o   Center the text.  Avoid using spaces or tabs to center the text.  Rather, from Word’s 

         “Home” tab, use Word’s “center” function to center the text. 

 

 
 

o Insert a page break after the title.   

 Click on the “Insert” dropdown menu at the top of the screen in Word 

 In the dropdown menu, hover your mouse pointer over the word “Break” 

 From the flyout that appears to the right of the word “Break” click on “Page 

Break” 

 

o Example: 

The Adventures of Tom Sawyer 
By Mark Twain 

 
- Insert Page Break Here – 

 

 Copyright page:  The copyright Page normally follows the title page.  It should also be centered 

with a page break after it, as shown here.   

 
Text copyright © 2012 John Q Smith 

All Rights Reserved 
 

- Insert Page Break Here – 
 
 
 



 Dedication:  If your book has a customized Dedication, it should follow the Copyright Page.  It 

should also be centered with a page break after it, as shown here:  

 

To my wife and kids for their love and support 

 
- Insert Page Break Here – 

  
 Preface/Prologue:  If you have a Preface and/or Prologue, they should follow the Dedication.  

These can be formatted like any regular book chapter, and each of them should end with a page 

break. These should come after your table of contents, which is described in the next section. 

By inserting a page break after each of these front matter elements, you will be giving each of them, in 

order, their own starting page, resulting in a professionally sequenced opening portion for your book. 

  

file:///C:/Users/placy/Desktop/tbd


Building Your Table of Contents 

 

In a Kindle book, the Table of Contents allows readers to jump to pre-determined places in the book by 

simply clicking on links embedded in the text. As page numbers are not applicable in a Kindle book (page 

counts change with the text size a reader chooses), a functional Table of Contents is one of the features 

Kindle readers rely on and expect.     

Kindle will recognize a properly implemented Table of Contents in Microsoft Word.  If your book is in 

Word, follow the steps below to ensure your table of contents works properly on Kindle.   

1. Identify your chapter headings and set your heading style:  

o You may have done this in the “Before You Write” section; if so, feel free to skip ahead 

to number two below 

o In your manuscript, highlight the first chapter title in your book with your mouse 

o Click on the “Home” tab 

o Click on the “Heading 1” button as shown below 

o Your chapter title text will be formatted differently.  You can change the formatting 

values for “Heading 1” to anything you wish by right-clicking on the same button and 

selecting “Modify” 

o If you have already formatted your chapter headings how you would like them to look, 

you can highlight the first one, right-click on “Heading 1” and select “Update Heading 1 

to Match Selection.” 

o Once you have set your chapter heading style, identify the rest of the chapter headings 

by repeating the first two steps above for each one. 

 

 



2. Insert your table of contents near the beginning of the Word document 

o You'll need to type out your Table of Contents by hand and then hyperlink each item to 

the correct place in your document. If you used Microsoft's "Heading" styles as 

described earlier, this will be straightforward. 

o To create a hyperlink, highlight the text you want to be linked and go to Insert > 

Hyperlink, or press Command-K.  

o In the "Insert Hyperlink" window, click on the "Document" tab, then "Locate" to select a 

place within your book to link to.   

o Expand the "Headings" section to choose a location from the text you've formatted 

using Heading styles. 

o Click OK twice and repeat for the remaining items in your Table of Contents. 

 

3. Set a bookmark so Kindle can find your Table of Contents 

Kindle offers readers the option to "Go To” certain places in a book such as the table of 

contents, cover, or the opening passage (such as chapter 1), from anywhere within the book.  

These places are known as "Guide Items."  To identify your table of contents as a guide item, 

follow these steps: 

o Highlight the words “Table of Contents” in your document   

o Click on the “Insert” drop down menu at that top of the screen in Word 

o Select “Bookmark”  

o In the “Bookmark name” box, type “toc” (without the quotes)  

o Click “add”  

 

4. Later revisions:  

If you add more chapters (or chapter headings) to your book after completing instructions 1-3, 

make sure you identify them as “Heading 1” (as you did in step 1 above).  To make sure your 

table of contents updates, click anywhere in your table of contents and hit the F9 key; this will 

add any new chapter headings and delete any removed ones. 

 

When you are done, you will have a professional quality table of contents that is properly created and 

situated within your document, correctly identified and linked to your chapter headings, and available 

for users to “Go To” on demand.   

  



 

Preparing a Cover 

 

When you upload your book, you will be asked to upload an image for your book cover.  Book covers 

influence sales, and we strongly recommend you give some consideration to the cover for your book.  

Below are some pointers to keep in mind as you prepare your cover.   

File Format / Dimension Requirements 

 a .jpg or .tif(f) file  

 at least 1000 pixels on the longest side 

 ideal image height/width ratio is 1.6 (example:  1000 x 1600) 

Information to Include on Your Cover 

 Title [title of the book] 

 Author [author(s) of the book] 

 Cover image [an image that captures the essence of the book and grabs customers’ attention] 

Developing a Cover  

 Professionally designed covers are available, usually at a cost.  Several firms, including freelance 

artists, offer cover design services.  A Google search for “ebook cover design” will yield a variety 

of different services.  Amazon does not recommend any single service.  

 You can design an image yourself.  To do so, you will need: 

o A digital design application where you will create the .jpg file containing your cover 

[such as Seashore, which is specifically developed for use on Mac, available for free 

download at http://seashore.sourceforge.net/] 

o Access to artwork [you can use artwork that you own or public domain artwork] 

o Access to fonts [you can use public domain or purchased fonts] 

Other Considerations  

 Share your cover with friends and colleagues for feedback.  

 Make sure text is clearly legible, especially when zoomed out.  Consider increasing font sizes and 

using contrasting colors to improve legibility. 

 If you do not have an image you wish to use, consider making use of public domain images or 

images for which copyright allows use with accreditation. 

 Select a font and color scheme appropriate for the tone and subject matter of your book.  

Rather than relying on default or frequently used fonts, consider websites offering free, 

commercially usable, downloadable fonts to create a more unique appearance for your cover. 

 The Amazon Kindle Store features plenty of top-selling book covers you can review as examples.    



Finished Covers 

Save your JPG on your desktop but do not include it in your manuscript; you’ll upload the files separately 

during the publishing process and we’ll combine the two for you in the finished product. 

 

 

  



Finishing Your Book 

 

Once you have completed your book and edited it for Kindle, there are a few basic steps required before 

you can publish your book.  These are outlined below:   

(1) Copyedit your manuscript 

 Be sure to run a spell check on your manuscript. Kindle readers expect a professional book; a 

few misspelled words can make the difference between a four-star review and a two-star 

review.  

 Re-review the formatting tips from this guide’s “Before You Write” section and verify you have 

not made any of the common mistakes.  Using the show/hide [¶] feature in Word is the best 

way to make sure there are no tabs, repetitive carriage returns, and other formatting errors that 

will impair the formatting of your Kindle book. 

 If you have not done so already, have a friend proofread your manuscript.  A fresh pair of eyes 

always helps, and it is easiest to fix any errors and make any required adjustments before 

proceeding to the next step.  

 (2) Convert Your Manuscript to HTML  

 Save your manuscript as an HTML document on your Mac someplace where you can easily find 

it (such as your Desktop).  To do this, just follow these steps: 

o Click on the “File” dropdown menu at the top left hand corner of the screen in Word 

o Click on “Save As” from the drop down menu 

o In the Save As dialogue screen that appears, select a location on your Mac where you 

will be able to easily find the file (we suggest the Desktop, which is usually available as 

an option on the left hand side of the Save As dialogue screen) 

o In the Save As dialogue screen, click on the “Format”  dropdown list 

o From the list of formats that appears next to the word “Format”, scroll down and click 

on “Web Page (.htm)” (in this guide, htm and html/HTML are used interchangeably) 

o In the lower portion of the Save As dialogue screen, click on the radio button 

immediately left of “Save only display information into HTML” 

o The bottom half of your “Save As” dialogue screen should now appear as shown below. 

 



o Click “Save” to leave the Save As screen and save the html document 

o Click the “File” dropdown menu in Word and click “Close” 

o Locate the files you just saved (we suggested you save on your Desktop).  There will be 

an htm file (we’ll call it mybook.htm in the next step).  If your Word document included 

images / photographs, a newly created folder will automatically appear named similarly 

to the htm file (we’ll call it the mybook folder).  If your book did not include images / 

photographs, there will not be a folder (only the htm file), and that is OK. 

 

(3) Books with Images: Creating a compressed (archive.zip) file of your book contents  

If you did not add pictures or images to your book, you can skip ahead to the next section of this guide 

(“Uploading and Checking the Quality of Your Book”).  

If your book includes images, you have both an htm file and a folder from Step 2 (there we called these 

mybook.htm and the mybook folder, respectively).  The steps below will walk you through creating 

what’s called a compressed file (also known as a zip, .zip file, or archive file), which will contain (in one 

file) both the htm file with your book’s text and the folder with all of the images.  

 Go to the folder where you saved your book as a .htm file.  Locate the mybook.htm file and 
mybook folder (where mybook is what you named your .htm file in Step 2; we will call it mybook 
below ). 

 We want to highlight both the mybook.htm file and the mybook folder at the same time.  To do 
this, left-click once on the mybook.htm file, which highlights the file.  Then, press down and hold 
the shift key on your keyboard.  With the shift key down, left-click once on the mybook folder.  If 
you are on your desktop, your screen should look something like this, with only the two items 
highlighted and no other items highlighted. 

 



 
Right click on the file mybook.htm and left click on the words “Compress 2 Items” 

 
 

 Your Mac will create an Archive.zip file in the same folder as mybook.htm (if you are on the 
Desktop, as shown in the images above, the new Archive.zip file will be on the Desktop).  The file 
icon for Archive.zip will likely have what appears to be a zipper on it. 
 

 
 
In the next section, you will upload this archive.zip file to Amazon KDP to publish your book. 

  



Uploading and Checking the Quality of Your Book 

 

Now it’s time to create your book on the KDP website.  To do this, follow these steps: 

 

Entering Details About Your Book (screen #1: YOUR BOOK) 

 

1. Log in at http://kdp.amazon.com/. 

2. Click on the “Sign In” link.  

3. You will be brought to the “Bookshelf” screen. 

4. Click on “Add new title.” 

You should now be at the Book Details screen #1 (YOUR BOOK) for your book.  Fill in each field, such as 

the title, description, categories, royalties, etc.  Follow the on-screen instructions to input these details.  

You can rely on the “What’s this?” pointers wherever you have questions. 

Here are some tips to help you with these aspects: 

o Your book’s metadata—i.e., its title, description, keyword, categories and all the other 

descriptive information—can help it find an audience.  If your book’s metadata does not 

reflect what your book is about, readers might not be able to locate it on our store. 

o Spend sufficient time on your “Description” under “Enter Your Book Details.”  Potential 

readers will very often read this description to determine if your book is something they are 

interested in reading. 

o In the “Book Contributors” field, make sure you at least insert someone’s name as “author.”  

You may also insert other contributors, such as editors or illustrators. 

o “Public domain” refers to classic works that were written by someone else but are no longer 

subject to anyone’s copyright (i.e., “The Adventures of Sherlock Holmes”).  

o Be sure you fill out every item on both the “1. Your book” screen and the “2. Rights & Pricing” 

screen. 

Once you have completed steps 1-4 on this page, you will be ready for… 

 

Uploading Your Book File(s) 

Now let’s upload your book content to KDP.  Here’s how to do that: 

1. Scroll down to the heading labeled “5. Upload Your Book File.” 

2. Click on the button “Browse for Book…” 

3. A pop-up window will appear.  Click the button called “Browse.” 

http://kdp.amazon.com/


4. Locate your book file on your computer, click “Open.” If your book does not have images, you 

will be uploading the HTML file you saved in step (2) of the last section. If your book does 

have images, you will be uploading the archive.zip file you created in step (3) of the last 

section. 

5. Click the “Upload Book” button. 

6. The message “Upload and Conversion Successful!” will appear on the page. This may take a 

few minutes, so please be patient – we are in the process of converting your book so that it 

looks great on Kindle! 

If you are not ready to proceed with publishing your book, go ahead and click "Save as Draft."  Your book 
will not be onsite, until you hit “Save and Publish.”  You can return to this page when you're ready. 
 

 Downloading the Kindle Previewer for Mac 

It is very important that you preview your book before you publish on KDP.  Amazon offers a Previewer 

tool for Mac that will help you do that.  Here is how to download the Previewer to your computer: 

1. Visit the following location on Amazon.com: 

http://www.amazon.com/kindleformat/kindlepreviewer.  

2. You will need to agree to the “Terms of Use” by checking the “I agree” box 

3. Click the Download Now button to the right of the words “Kindle Previewer…for Intel Mac”. 

4. Follow the instructions to save the Previewer tool to your computer. 

5. The name of the application on your Mac will be “Kindle Previewer” without the quotes.  If you 

know how to find it and open it, do so now.  If not, the next three steps will help you. 

6. Click on Finder from your Dock (the Dock is the bar usually at the bottom of the screen showing 

icons for various applications).   

7. Type “Kindle Previewer” without the quotes in the search box in the upper right, and press 

Enter. 

8. The search results will populate.  Click on the Kindle Previewer application; this will open the 

Previewer tool on your Mac. 

 

 Previewing Your Book 

Now that your book has been uploaded in KDP and you have the Previewer downloaded to your 

computer you can take a look at how your book will appear on Kindle devices. To view your book on 

Kindle, go to the KDP page where you uploaded your book content and click on “Download Book 

Preview File” in the “Enhanced Previewer” box under section six, Preview Your Book.  The file will save 

to your “Downloads” folder. Once you open Kindle Previewer, select “Open” from the File menu, 

navigate to your Downloads folder and select your book. 

1. Review your front matter (i.e., title page, dedication, copyright information, preface, etc.). 

2. Ensure that your linking table of contents works (if applicable). 



3. Don’t be concerned if your cover doesn’t appear – we will embed the cover when it is time to 

publish. 

4. Proofread your Kindle book’s contents:   

a. Look for characters that may not have converted correctly. 

b. If you need to make any changes, write them down (you will address them in the next 

section).    

5. Check your book’s presentation across various devices (recall that Kindle books can be read on 

multiple devices and applications, including Kindle, Kindle Fire, KindleDX, Kindle for iPad, and 

Kindle for iPhone, each one of which can be emulated in the Previewer). 

a. In the Previewer, select “Devices” from the drop-down menu. 

b. Select the device which you would like the Previewer to emulate. 

c. The reading experience may be slightly different on each device, but if you followed the 

formatting tips provided, the differences will be minimal. 

6. Close out of the Previewer. 

 

 

 Making Changes and Uploading Your Revised File(s) 

This step is only applicable if you identified changes that you would like to make based on the 

proofreading of your book that you just completed.  If no changes are required, you are done with 

uploading your book and are now ready for the “Before You Publish” section that follows next in this 

guide. 

If you need to make edits, go to the HTML file of your book on your computer, right click, scroll over 

“Open with” and select Microsoft Word. If you have images in your book and created a zipped folder to 

upload to KDP, make sure to use the HTML file that is in this zipped folder. Make any edits or changes 

needed. Consider saving your drafts under different titles (e.g., v2 or 2nd Draft) for easier identification.  

Once you are done, click save as (adjust “save as type” field to: Web Page, Filtered) and close the file.   

To re-upload your revised content:  
 

1. Check the box at the left side of the book and then click on the "Actions" button at the top left. 
2. Select 'Edit book details' in the menu.  
3. Scroll down to the Book Content section and click 'Browse for Book.'  
4. Browse to your updated book file. If you have images, this will be a zipped folder. If not, it will 

be an HTML file.   
5. Select the appropriate file, click open, and click 'Upload Book.'  

6. Click 'Save and Continue.'  

 

 

You can repeat this process as many times as you like until you are satisfied with your book.  Once you 

are satisfied with the draft of your book you are almost ready to publish! 

  



 

 

Just Before Publishing Your Book 

 

You have already uploaded your book content and book details.  Only one step remains before you can 

publish you book.  When you hit “Save and Continue” in the previous section you were sent to the Book 

Details screen #2: RIGHTS & PRICING. 

Follow the on-screen instructions to enter your rights and pricing information.  Again, you can rely on 

the “What’s this?” pointers throughout the process wherever you have questions. 

Once you’ve completed the “Your Book” and “Rights and Pricing” sections and are ready to publish your 

book, hit the “Save & Publish” button on the bottom of the screen and you’re done!  Your book will 

appear on your KDP bookshelf, but it will not be editable until it completes the publishing process 

(generally 24-72 hours).  It will appear in the Kindle Store within the 12 hours if it’s an English language 

book, and within two days for all other languages. 

 

Congratulations, you are now published! 

 

 

 

  



 

Making Changes after Publishing Your Book 

 

 

You may want to make corrections after you have published your book.  This section addresses how you 

can make any changes and how KDP can alert your customers that changes have taken place. 

Making Changes to a Converted Text 

 

If you have modified your original manuscript (i.e., corrected some typos) and now you want to transfer 

those changes to your converted, published book you will need to follow these steps: 

1. Check the box at the left side of the book and then click on the “Actions” button at the top left. 

2. Select “Edit book details” in the menu 

3. Scroll down to the “Upload Your Book File” section and click “Browse for Book”  

4. Browse to the HTML file you wish to upload (the latest version of your book) 

5. Click “Upload Book”  

6. Click “Save and Continue”  

7. Go to the 2nd page (“Rights & Pricing”) 

8. You'll need to reconfirm Content Rights and click “Save and Publish” 

Changing Your Book's Details 

 

You may also want to make changes to your book's details (e.g., the title, description, categories, 

royalties, etc.)  You can do so at any time by returning to the "Bookshelf" tab and following the steps 

below.  

1. Select the "Actions" drop-down menu next to the book you wish to modify. 

2. Click on either "Edit book details" or "Edit rights, royalty, and pricing." 

3. Enter the changes you would like made. 

4. Click “Save and Continue,” then click "Save and Publish." 

Alerting Customers of an Updated Version of Your Book 

 

If you make changes to your book and you want your customers to receive the updated version, we can 

assist with the process.  We will need you to provide us with some information first. 

  

In such a case, we will ask you to write to us using the “Contact Us” tool. You can find this in the bottom 

right-hand corner of any page on the KDP website. 

 

When you send us a message regarding alerting customers of an update to your book, please provide 

details and specific examples of the corrections made to the book. The more details that you provide, 

the better we will be able to accurately categorize and message any update to your customers. When 



we receive the details, we will perform a review of your book and take appropriate action within two 

weeks. The possible results of our review include: 

 If the changes made to your content are considered major, we’ll send an email to all customers 

who own the book to notify them that the update exists.  These customers can choose to 

receive the update through their Manage Your Kindle page on Amazon.com.  

 If the changes made to your content are considered minor, we won’t be able to notify all 

customers by email, but we will enable them to update the book’s content through the Manage 

Your Kindle page on Amazon.com. 

 If the changes made to your content have caused unexpected critical issues with the book 

content, we’ll temporarily remove your book from sale. We’ll notify you of the issues we found 

so that you can fix them.  Once the improvements are made, just let us know and we’ll email 

customers just as in case 1. Once our review is complete, we’ll email you to share the results 

and actions taken. 

 

 

 

 

 

 

 

 

 

 


